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1 Programme Design 

The following chapter offers an overview of the various functions and the most important 

components of the programme. First, the available menus are explained in brief (section 1.1). 

In section 1.2 the menu bar is described, and section 1.4 contains an overview of the main 

mask and the particular sections. In the final section of this chapter, there is a comprehensive 

overview of the additional user dialogues available.  

1.1 Menus 

In order to control the single functions of the programme, several menu options are available 

to the operator. Once the programme has been started, the menu bar offers five menu levels as 

shown in Illustration 1-1 below. The File menu level holds all the functions required to 

open, to save, to print, to create a new measurement, or to finish the measurement and to close 

the programme. Illustration 2-1 shows the expanded File menu. The  Edit menu level 

offers context-related filtering and calculation functions and user dialogues. This means that 

these functions are available only when the programme fulfils certain conditions concerning 

mode, input data, activated level, etc.. For example, a filter function is available only if a 

measurement has been carried out beforehand.. The Measurement menu level contains all 

the functions of the programme regarding the start and the stop of a measurement. In the  

Preference menu level, the characteristics of the programme can be changed. This 

especially applies to the language setting. Also, the kind of measurement section is 

determined through this menu level. For further details about the single menu levels and their 

functionalities, please refer to chapter 2. The Help menu level contains the information 

dialogue of the programme providing the user with information on the programme version 

and on the contact details,  if it is required to contact F.A.S.T. GmbH.  

 

Illustration 1-1: Menus 

1.2 Menu bar 

The menu bar under the menu provides the user with functions which can be activated 

through the menu as well but which require quick access as they are used frequently. Here as 

well, the applicable functions are context-related and thus are not available in general. If 
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certain functions cannot be used due to the context, these functions are shaded grey in the 

menu bar. Illustration 1-2 below illustrates the menu bar. For a detailed description of the 

single functions, please refer to chapter 2.6. 

 

Illustration 1-2: Menu bar 

1.3 User Dialogues 

In order to generate any information relevant for the further calculation process, the 

programme offers various additional dialogues which enable the user to add and to save 

additional measurement-related information as a text or as a diagram. If such information has 

to be provided in a text format, a text dialogue can be used to draft reports (see chapter 4.1). 

This text can then be printed out together with the correlation and coherence diagrams. Also, 

a comfortable dialogue to generate and to process new kinds of pipelines is available for your 

convenience. This dialogue helps you to integrate new kinds of pipelines into the programme 

or to modify already existing kinds of pipelines. For further information on this dialogue, 

please refer to chapter 4.4. On the basis of the particular pipe details, the user can define the 

measurement sections to carry out new measurements through the dialogue as described in 

chapter 4.5. Sometimes it is requested for documentation purposes to put down the details of a 

location in a sketch. Therefore, the programme offers a dialogue (see chapter 4.2) with  which 

sketches can be generated. This dialogue enables the user easily graphically to document 

certain conditions. If the programme is used by service providers who have to report to their 

customers, the address dialogue (see chapter 4.3) can allocate a certain service provider 

address. This address will be shown as the sender on the report print-out. 

1.4 Main Mask 

Once the programme has been started, the main mask as shown in Illustration 1-3 will appear 

on the screen. You can now reach all the settings and functions of the correlator. Besides, the 

mask also shows you the results of a particular measurement. When you want to set the filters 

for the correlator to be adjusted for a new measurement and to improve the results arising 

from this particular measurement, go to the left-hand part of the main mask. Here you also 

find the setting options for amplification, the averaging factor, and the activation and de-

activation button for Trans Auto. In the lower part of the mask, the spectrums or the time 

signals of channel A and B as well as the input measurement distance between the diagrams 
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are shown. The mask sections on the right-hand side and in the middle of the mask show the 

displays for the correlation and coherence diagrams. Here the user can make any changes on 

the digital filter limits as soon as the particular measurement is finished. For detailed 

information on the single functions and sections of the main mask, please refer to chapter 3.   

 

 Illustration 1-3: Main mask 
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2  Menu Functionality 

Chapter 2 is to explain the single menu levels including the particular sub-menus in detail. 

First, chapter 2.1 is to describe the functions related to the Files menu. Chapter 2.2 then 

deals with the  Edit menu level. Chapter 2.3 is to describe the functions of the Measuring 

menu level, and the chapters 2.4 and 2.6 are to give information on the scope of functions of 

the Preference menu level and on the menu bar. 

2.1 Files 

In the Files menu level you will find all functions related to printing, filing, saving, and 

loading a measurement as well as to cancelling the programme. In order to be able to carry 

out a measurement, a new measurement object has to be created in the programme. This is 

done either by clicking on New (as to be seen in Illustration 2-1) or by pressing the shortcut 

Strg+N. Both procedures lead to the same result and either will help you to create a new 

measurement object in the programme. The programme is now capable of carrying out 

measurements. This “ready-to-measure“ mode is indicated by an activation of the keys used 

to set the filters and amplification – the keys are not shaded grey any more. Moreover, the 

diagrams for the channels A and B (see chapter 3.9) now show the current time signal. If the 

measurement to be carried out has been started according to the procedure as described in 

chapter 2.3, the programme is now ready to start on the measurement procedure. 

 

Illustration 2-1: Files menu 

The next menu level enables the user either be clicking on Open or by pressing the shortcut 

Strg+O to open those measurement procedures which have already been carried out and 

saved. If any of the above options is implemented, the dialogue as shown in Illustration 2-2 

opens up. Now the user can select a correlator programme file which has the ending .kor  

and load this file into the programme by clicking on the Open button. In contrast to an on-

going measurement procedure, the analogue filter settings and the amplification factors as 
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well as the averaging factor for the loaded measurement cannot be changed. However, the 

loaded measurement can be filtered digitally again, and changes can be made on the 

measurement section. 

 

Illustration 2-2: Opening dialogue 

The next two menu levels as shown in Illustration 2-1 are used to save finished 

measurements. The difference between Save and Save as is the different way of saving the 

data. When the  Save as button is clicked on, the dialogue as shown in Illustration 2-3 will 

appear. When Save is clicked on, there will be no dialogue appearing on the screen if the 

measurement has already been saved at a previous point of time because the path and the file 

name have already been used to save the particular measurement and thus are known to the 

programme. 

  

Illustration 2-3:  Saving dialogue  

The Institute page menu level is to enable the operator to select the requested paper 

format as well as the horizontal or vertical alignment of the print-out before the printing 

process is started. The report will be printed out by pressing the Print button. This report 

contains all information as input in the report (see chapter 4.1), the sketch (see chapter 4.2), 

the address of the service provider (see chapter 4.3), and the measurement section (see chapter 

4.5) dialogues as well as the filter setting and amplification factors, the measurement result 

and the correlation and coherence diagrams. Usually, the report has two pages. Pressing the 

Cancel button shuts down the entire correlator programme. 

- 11 - 



2.2 Edit 

The “Edit“ menu level is a menu which is entirely dependent on the particular context. This 

means that all the functions hosted in this level are available only under certain conditions and 

in certain programme modes. The first four menu levels are available only when a 

measurement has been finished. For a detailed description, please refer to chapter 3.5. The 

final two menu levels are available as soon as a measurement object has been created, as 

already described in chapter 2.1. 

 

Illustration 2-4: Edit menu 

With the Filter and Aut. Filter functions, the digital filters of the correlator programme 

can be set manually and automatically respectively. Unlike the analogue filters, the digital 

filters cannot be set before a measurement has been finished. Therefore, the two digital-filter 

functions are not available before the measurement has been finished, i.e. the digital filters are 

not activated before the measurement has been finished. Please note that Filter and Aut. 

Filter differ basically in their operation. Setting the filters manually is started either by 

clicking on Filter or by pressing the shortcut Strg+F. However, the filter limits have to be 

determined in the coherence diagram with the mouse beforehand for proper filtering purposes. 

The determination of these limits is described in chapter 3.7. Starting the fully automatic 

filtering mode is done by clicking on Aut. Filter or by pressing the shortcut Strg+A. 

The automatic mode does not require any preliminary work and can be started directly 

through the menu level or through the shortcut. Both functions lead to the same filtered 

correlation curve, which is displayed in the diagram as soon as the filter setting process has 

been finished. 

The Calibrating menu level enables the user to determine the sound velocity related to a 

certain pipe section. This sound velocity is displayed in the Measurement section dialogue 

(see chapter 4.5). This function, alike the digital filter setting function, cannot be activated 

before the measurement has been finished. For a detailed description of the sound velocity 

calibrating process for a pipe section, please refer  to chapter 3.8. 
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If you have shifted the maximum mark of the correlation manually, you can automatically 

position the line to the maximum correlation result by clicking on the “Maximum” menu level. 

Please note that  re-positioning the maximum mark will start a new calculation of the leakage. 

For a detailed description, please refer to chapter 3.1. 

In contrast to the menu functions mentioned so far, the Report and Sketch menu levels can 

be applied as soon as a measurement object has been created (see chapter 2.1). Clicking on 

Report or pressing the shortcut Strg+R opens the report dialogue as described in chapter 

4.1. This dialogue can be used to add further information to a particular measurement 

procedure. Similar applies to the dialogue to be called with the Sketch menu level. Here a 

certain situation can be displayed graphically, and this information can be allocated when the 

measurement is saved. Calling the menu level can also be done by pressing the shortcut 

Strg+Z. Either ways lead to the same dialogue, which is described in  chapter 4.2.  

2.3 Measurements 

With the Measurement menu, a measurement run is started. This menu as well depends on 

the context, and two of its functions cannot be activated before a measurement object has 

been created (see chapter 2.1). The other two functions can only be used when the 

measurement has already started or when it has been finished. 

 

Illustration 2-5: Measurement menu 

Pressing the F1 key or clicking on Start measurement starts the manual measurement 

process. Please note that the analogue filters, the amplification factor, and the averaging 

factor as well as the Trans Auto functions have to be set by the user prior to the start of the 

measurement. For a detailed description of the setting options, please refer to chapter 3. In 

contrast to the manual measuring mode, the automatic measuring mode automatically sets 

amplification and - when the measurement has been finished – the digital filters. The 

automatic measuring mode can be started either by clicking on the Automatic 

measurement button or by pressing the F5 key.   
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The Stop measurement button can be used only during the measurement process itself; it 

discontinues the on-going measurement process. This function as well as the other menu 

functions can also be started by pressing the F2 key.  

When you click on Quick Measurement, a measurement process will be carried out on the 

basis of the parameters set in the Measurement Procedure window. The parameters for 

the measurement process can be changed by clicking on the  button located in the menu 

bar or through the menu Preference à Measurement Procedure. For further details 

about the Measurement Procedure window, please refer to chapter 2.4. 

The final menu level to be explained is Delete measurement. This function is available as 

soon as a measurement has been finished. It deletes all the information related to a particular 

measurement in the dialogues and in the main mask. When applied, the function resets the 

programme to the start status.  

2.4 Preference 

The Preference menu holds all the functions required to adapt the programme to the user’s 

requirements. This especially applies to the language and pipe definition features. 

Furthermore, the displays of the channel diagrams for channel A and channel B can be 

changed, the measurement section is created, and the parameters for the GPS receiver 

interface are set through this menu. 

 

Illustration 2-6: Preference menu 

The first menu level enables the operator to change the display for the channel diagrams as 

shown in Illustration 1-3 in the lower part of the main mask. On the one hand, the diagrams 

can show the current time signal of the channel, and, on the other hand, they can show the 
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spectrum of the channel during the measurement procedure. Clicking on Channel diagram 

takes the user to a sub-menu which offers two options: either Time signal or Spectrum. 

The display mode currently activated in the channel diagrams is indicated by a tic in front of 

the menu level. 

The channel selection feature in the Preference menu level allows you to integrate 

another measurement box into the correlation process and to switch between these three 

measurement boxes. The Channel Selection menu offers you the three possible 

combinations arising from the measurement boxes A, B, and C. (see Illustration 2-7 ). 

 

Illustration 2-7:  Channel Selection 

By clicking on Add measurement section or by pressing the shortcut Strg+M, the 

dialogue described in Chapter 4.5 will open. Double-clicking on the pipe schematics as shown 

in the lower parts of Illustration 1-3 will have the same result. In this dialogue, the operator 

can combine up to seven pipe sections for the measurement.  

The Measurement Procedure menu level is to assist you in determining the run of the 

measurement. Here you can (de-)activate the analogue filters, the amplification factor, the 

Trans-auto function, and the automatic mode for the digital filters. Also, the number of 

repetitions can be set in this menu level. 

The Process material definitions menu level enables the operator to integrate new 

kinds of pipelines into the programme or to process already existing pipe sections. In order to 

do so, the dialogue described in chapter 4.4 has to be opened.  

With the Transauto Sensitivity menu level you can adjust the sensitivity level of the 

Trans-auto function in per cent. 

If you want to change the language used for the dialogues and for the main mask, go to the 

Language menu level. The following languages can be activated if the appropriate language 

file has been saved in the corresponding folder of the programme: 
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• German 

• English 

• French 

• Italian 

• Spanish / Portuguese 

• Swedish / Norwegian / Danish 

• Polish 

The programme features German and English as a standard. These two languages are not 

shaded grey in the Language menu level and that they are available as soon as the 

programme has been started. All other languages have to be installed by the operator as 

described in chapter 5.2. When the language is changed, all the dialogues in the programme 

and the report print-out are converted to the particular language. Please note that the names of 

the kinds of pipelines described in chapter 4.4 will not be converted automatically into 

another language and have to be converted separately as described in chapter 5.1. 

Service providers have the option to have their corporate address printed on the report head. 

This can be set in the Service provider address menu level. If a certain address has 

been lodged in the dialogue, this address will be used for and printed on every report print-out 

until the address is changed. Concerning a detailed description of the dialogue, please refer to 

chapter 4.3. 

The correlator programme features an interface capable of accepting GPS-related signals. 

Such signals are required to determine the exact position of a location. The sub-menu of the 

GPS menu level helps the operator to configurate the interface for the GPS receiver, and it 

also assists in carrying out a functional test for the receipt of the GPS data through the 

dialogue as described in chapter 4.6. For further information on how to connect the receiver, 

please refer to chapter 5.3. 

The final function in the Preference menu is the Communication function. Here those 

parameters are adjusted that are required for the communication process with the correlator 

box. Communication of the programme is implemented through a virtual serial interface 
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which is established by means of a USB connection. Select the corresponding Com-Port to 

which the correlator has been connected. All other settings can be made as shown in 

Illustration 2-8. 

 

Illustration 2-8: Com-Port Settings 

When you have set all parameters, click on the Accept button to save the settings in the 

correlation programme. The programme will then close down automatically to enable the 

system to apply the new settings properly. If you click on Back, the window will be closed 

and your input will not be saved. Please note that in this case it will not be possible to start a 

correlation procedure. 

2.5 Help 

The Help menu provides the user with the information dialogue as described in Illustration 

2-9. Press “Help“ to open the illustration, which informs you about the programme version 

currently installed on your correlator. Furthermore, the F.A.S.T. GmbH contact details are 

listed on this illustration. 

 

Illustration 2-9: Information dialogue 
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2.6 Menu bar 

As already mentioned in chapter 1.2, the menu bar offers some functions which demand quick 

access to the programme due to their repeated usage. Therefore, the menu bar is divided into 

three sections by 2 vertical lines. This separation abstracts the first three menus: Files, 

Edit, and Measurements and offers the menus’ most frequently required functions. 

 

Illustration 2-10: Menu bar 

The functions available at the Files menu are as follows: New, Open, Save and print. 

These functions are represented by the same symbols used at the menu bar of the Files 

menu. Concerning the functionality of and the range of applications for the functions of this 

group, please refer to chapter 2.1. 

The next group of symbols represents the functions available in the Edit menu. The single 

functions are: Filter,  Aut. Filter, Maximum, and Calibrate. These functions too, 

like their equivalents in the Edit menu, are available only in a certain programme mode. For 

further information on this function, please refer to chapter 2.2. 

The third group of symbols is about two functions of the Settings menu and two functions 

which are available only in the menu bar. The functions of the Settings menu are 

"Measurement Process" and "Transauto Sensitivity". The other two functions are 

the automatic adjustment of the channel amplification factor and automatic adjustment of the 

length of the pipeline section. For further information, please refer to Chapter 2.4. 

The fourth group of symbols in the menu bar represents the menu levels of the Measurement 

menu. The first selectable function is Start Measurement, the second function is 

Automatic Measurement. However, these two functions are not always available and thus 

marked grey in the menu bar as can be seen in Illustration 2-10. The availability criteria for 

the functions and for the results related to these functions respectively are similar to the 

availability criteria effective for the Measurement menu. For further information on the 

functions, please refer to chapter 2.3. 

The final symbol in the menu bar relates to the indication of voltage. Clicking on the symbol 

opens a dialogue where the values for the power supply voltage and for the voltage supplied 
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by the accumulators are displayed. This window also indicates whether or not the receiver and 

the headphones are (de-)activated. The readout in green is the currently applied power supply. 

So the dialogue shown in Illustration 2-11 indicates that power is being supplied by the 

accumulators. If the device were operated with line voltage, the indication for mains voltage 

would be marked green and the display for power to be supplied by the accumulators 

(Accumulator Power Supply) would be marked white. The illustration below, however, 

shows that the device is operated with the power supplied by the accumulators. 

 

Illustration 2-11: Voltage indication 

The displayed power value should range in the green area. If the pointer has left the green 

area, power for the device should be drawn from the mains. For your safety, check the power 

supply value indicated when you have changed from accumulator-driven operation to mains 

power supply. If the pointer ranges in the blue field, the measurement procedure may be 

continued. If the pointer ranges in the red field, it is no longer feasible to carry out a 

measurement procedure. 
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3 Main Mask 

The most important information and functions are accessed through the main mask. This main 

mask can be divided into nine sections as described in chapter 3.1. The following chapters are 

to assist you in developing the measurement process with the programme. Chapter 3.2 

describes the creation of the measurement section, and chapter 3.3 as well as chapter 3.4 are 

to provide you with information on how to set the analogue filters and amplification. The final 

measurement procedure is described in the chapter 3.5 and in chapter 3.6. The final chapters 

are to inform the operator about the options on how to rework the measurements that have 

been carried out. 

3.1 Main mask sections of the programme 

The main mask as shown in Illustration 3-1 and in Illustration 3-2 can be divided into nine 

sections. Some sections serve information display purposes, others are used to combine and to 

make available certain programme functions. In the first section, the correlation after the 

measurement has been finished is displayed in green. This section also shows the distance 

between measuring boxes A and B by means of vertical lines with various colours. The 

section between the lines reflects the particular measurement section currently dealt with. 

 

Illustration 3-1: Main mask sections 1 
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The maximum correlation is also displayed in this section with a small red vertical line. The 

programme automatically draws both this line and the correlation into the diagram when the 

measurement has been finished. The operator may, however, position this line in the diagram 

wherever he/she wants by double-clicking on it with the left mouse key. Please note that 

repositioning the maximum line will result in another leakage calculation. This also means 

that if you position the line outside the measurement section, you will either receive a zero-

distance between the leakage and measuring box A or the programme will indicate the 

maximum pipe length. If the maximum correlation is indicated to be outside a measurement 

section as soon as the measurement has been finished, either the selected sound velocity is 

incorrect or the leakage is not located in the measurement section. In case of an incorrectly set 

sound velocity, the sound velocity can automatically be adapted to the pipe section through 

the Calibrate function (see chapter 3.8). Furthermore, the scale size of the correlation in 

the diagram can be changed through the Image up and Image down keys (similar to a zoom 

function).  

The blue diagram as shown in section 2 shows the coherence of the current measurement 

procedure. In addition, the digital filters for manual digital filtering purposes can be drawn in 

into this diagram. If such digital filters are not applied and the operator uses the automatic 

filtering mode, the filter limits determined by the programme will be drawn in as soon as the 

calculation process has been finished. When the digital filters have been used, the correlation 

diagram will be updated in section 1, and the position of the leakage location will be 

calculated again. For further information on how to draw in and how to determine the filter 

limits for the manual filtering mode, please refer to chapter 3.7. 

The section which is used to set the correlator, is section 3. Here the operator can change the 

amplification factor for the received signal for each channel separately. So the signal received 

by the measuring boxes A and B at the correlator can either be amplified or cushioned. For 

further information on how much to amplify or to cushion a signal, please refer to chapter 3.4.  

In the fourth section in Illustration 3-1, the results are displayed. On the one hand, this section 

displays the averaged values for the particular measurement carried out, and, on the other 

hand, it also indicates the leakage position. Section 5 in Illustration 3-1 shows the menu 

functionality of the programme and has already been described in Chapter 2. 

Section 6 (to be seen in Illustration 3-2) provides information on the analogue filters of the 

programme. These filters have to be set prior to the measurement procedure as they cannot be 
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changed once the measurement has been finished. One high-pass filter and one low-pass filter 

are available for analogue filtering purposes of the signals. For further information on the 

filtering process, please refer to chapter 3.3. 

 

Illustration 3-2: Main mask sections 2 

Section 7 shows the setting options for the Averaging factor and for the Trans Auto 

function. When the Trans Auto function is activated, the programme is capable of 

eliminating disturbing noises occurring during the measurement procedure and of using only 

such noises that are actually generated by a leakage. By raising the Averaging factor, the 

exactness of the measurement process will be increased indirectly. Each averaging process 

results in a measurement procedure, and the result of this measurement is added to the 

measurement result received previously. The more measurements are carried out, the more 

exact the result of the overall measurement procedure will be. 

Section 8 is used to display the two channel diagrams and graphically to display the pipeline. 

It is also used to illustrate the leakage in the measurement section. The illustration of the 

channel diagrams can also show either the time signal of the channels or the spectrums of the 

channels (see chapter 3.9). Furthermore, the dialogue described in chapter 4.5 will appear on 

the screen by double-clicking on the field Measurement Section.  
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In order to set an amplification factor appropriate to the signals received (if required), the 

volume indicator in section 9 displays the volume of the time signal currently set. The red 

volume bar left of the coherence diagram refers to channel A, and the volume bar right of the 

diagram refers to channel B. If the signal is too low to be processed by the correlator, the 

volume bars will show a yellow bar. In this case, the operator has to increase the amplification 

factor for the particular channel. If, however, a red bar is displayed, the signal is excessive 

and cannot be processed properly by the correlator. In this case, the amplification level for the 

particular channel has to be reduced, if possible. A green indication with the bar being in the 

middle of the scale is reflects the optimum amplification factor and does not require any 

corrections. 

3.2 Creating a measurement section 

Before you start with a measurement procedure, you have create a measurement section in the 

programme as the programme needs to be able to calculate the distance to the leakage once it 

has acquired and evaluated the signals. In order to create a measurement section, you require 

the dialogue as described in chapter 4.5 (Set measurement section). Please open this 

dialogue and determine the particular section to be measured. You can combine up to seven  

pipe sections (partial sections) to one measurement section. Make sure that the partial sections 

have to be input originating at measuring box A. The partial sections will be displayed  in the 

Measurement section field of the main mask as soon as the settings have been accepted. 

 

Illustration 3-3: Measurement section 

The drawing in the Measurement Section illustration abstracts the underground pipe section 

defined by the operator. The single partial sections are drawn in one by one in blue and 

separated from each other with a grey flange-type line. They appear in different lengths 

reflecting their original lengths that have been entered by the operator. In order to provide you 

with a quick overview, the dimensions of the entire measurement section as well as of the 

partial sections are also drawn in. The dimensions are marked red and are written below the 

pipeline. So, coming from top, first the dimensions of the partial sections are shown, and then 
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the dimensions of the entire pipe section are stated. Furthermore, this section displays the 

result of the leakage-related calculation. The distance between the physical leak and 

measurement box A is always displayed above the drawn-in pipeline, and the dimensions are 

shown in green. The distance refers to the position of the measurement box and is indicated in 

metres. When you have entered all the settings for the measurement section, you can proceed 

by setting the analogue filters.  

3.3 Setting the analogue filters 

Before you start on the measurement itself, the analogue filters have to be set. The filters 

suppress undesired frequencies (disturbing noises). So the high-pass filter of the correlator 

accepts only those frequencies which are above the frequency as shown on the display. All 

lower frequencies are suppressed by this filter. The low-pass filter, in contrast, enables you to 

accept those frequencies which are below the indicated low-pass frequency and to suppress 

high frequencies. Therefore, you should make sure that the filter settings do not overlap each 

other as otherwise the programme cannot acquire any signals required to calculate the 

leakage. In addition, it is recommended to use a reasonably wide frequency range which 

contains the leakage and which can be processed by the correlator unit without any filters.  

 

Illustration 3-4: Analogue filters 

Other key factors for the appropriate setting of the filters are the pipe material and the length 

of the pipe section. Experienced operators are able to select the suitable filter settings on the 

basis of these two parameters. However, also other factors and the size of the leakage itself 

may have an impact on the selection of the appropriate filters. Also, when the measurement 

section features different pipe materials, the softest pipe material should dominate the 

selection criteria for the filters. So there is no general procedure on how to select which 

filters, but the following table is to give you some clues. 
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PE hard, PE soft, PVC 

distance in 

metre 

0 - 20 20 - 50 50 - 100 > 200 

HP filter 100 50 25 25 

steel, cast iron 

Distance in 

metre 

0 - 50 50 - 200 200 - 400 > 400 

HP filter 400 200 100 25 or 50 

asbest cementos 

distance in 

metre 

0 - 50 50 - 200 200 - 400 > 400 

HP filter 200 100 50 25 

 

3.4 Changing amplification 

Another important point to keep in mind is that the amplification factor for the particular 

channel has to be set before the measurement starts. If a signal for the channel is too weak or 

too strong, the correlator will not receive optimal information, and the measurement will be  

distorted. 

 

Illustration 3-5: Amplification factors 

As each pipe fracture generates its individual noise level, the programme has to be adjusted 

accordingly before the measurement process is started. Section Amplification offers the 

choice of five different levels of amplification to be set for the each channel separately. In 

order to identify and thus to set the appropriate amplification level, the two volume indicators 

to the right and to the left of the coherence diagram provide the operator with graphical 
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information on the particular signal volumes. The volume indicator on the left-hand side 

refers to channel A, and the volume indicator on the right-hand side refers to channel B.  

The higher the bar in the volume indicators, the stronger the signal at the corresponding 

channels. You should select the amplification level for the channels appropriately so that the 

bars are displayed in green and are positioned in the middle of the level indicator. If a bar is 

displayed in red permanently, this means that the channel is overmodulated (= too loud) and 

amplification has to be reduced. If the bar is displayed in yellow, amplification is too low and 

thus the signal is too weak. Amplification for the particular channel needs to be increased 

then. 

When all pre-settings (measurement section, analogue filters, amplification) have been made, 

you can start on the actual measurement procedure itself. Remember that you do not need to 

set amplification when you intend to carry out the measurement in the automatic 

measurement mode. 

3.5 Manual measurement mode 

In order to apply the correlator programme appropriately for measurements, you need to 

create a new measurement object in the programme. This is done by as described in chapter 

2.1. The difference between operation in the automatic mode and operation in the manual 

mode is the course of action required to set the filters and the amplification factors for the 

channels. Before you can start with the manual measurement procedure, you will have to set 

the high-pass and low-pass filters. For further information, please refer to chapter 3.3. Once 

you have set the filters, it is mandatory to correct amplification for the channels A and B, if 

required (see chapter 3.4).  

Please make sure that the signals are received with the appropriate volume. The volume 

indicators in the programme will help you to determine the suitable level. When all necessary 

settings have been done, you can start the measurement process through the menu bar (see 

chapter 2.6) or through the Measurement menu (see chapter 2.3). During the measurement 

process, the new correlation and the coherence will be displayed in the corresponding 

diagrams after each measurement run. When the number of measurement runs reaches the set 

averaging number (see chapter 3.1, section 7), the programme will discontinue the current 

measurement procedure, and you can start to rework the measurement. (see chapter 3.7 and 

also chapter 3.8). If it proves to be necessary to stop the measurement procedure before the set 
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averaging number of measurements has been reached, you can immediately leave the 

measurement mode by pressing the Stop button (see chapter 2.6). 

When the measurement has been finished, the programme will immediately calculate the 

distance between the leak and measurement box A. This distance will be displayed in the 

corresponding sections of the main mask (see chapter 3.1 or chapter 3.2). If the measurement 

is reworked, the distance between the leakage and the measurement box A may differ from 

the initial result. 

3.6 Automatic measurement mode 

In contrast to the manual measurement mode, the automatic mode does not require that much 

preliminary work and reworking. Also, the automatic measurement mode automatically 

allocates the digital filters to the coherence when the measurement process has been finished.  

When you intend to carry out a measurement in the automatic mode, you first have to create a 

measurement object in the programme (also see Manual Mode, chapter 2.1). When the object 

has been created, you only have to set the high-pass and the low-pass filters for the 

measurement process. Then start the measurement procedure as described in chapter 2.3 and 

in chapter 2.6. Before the measurement is started by the programme, however, the programme  

checks the settings and the amplification levels. If the programme detects any insufficiencies 

in the settings, it automatically adjusts the amplification factors. When the number of 

measurement runs has reached the averaging number, the programme stops the measurement 

process and proceeds with the automatic filtering process of the coherence. Calculating the 

filter limits may take up to ten seconds. When the filter limits have been determined, the 

calculated limits are drawn in into the coherence diagram and the illustration will be adapted 

to the correlation. 

If requested, you can also manually filter the measurement results digitally when the 

measurement procedure is finished. Please refer to chapter 3.7 for further information. The 

distance between the leakage and the measuring box A is indicated in metres and is displayed 

as soon as the measuring and filtering processes have been finished. 

3.7 Setting the digital filters 

An adequate function to raise the exactness of the measurement results is digital filtering of 

the coherence. This filtering method enables the operator to suppress those disturbing noises 
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displayed in the coherence by determining an appropriate filtering range and by calculating 

the leakage again without any disturbing noises. The programme offers two filter options for 

such re-calculation purposes. The operator can either filter the results manually by 

determining the filter limits himself/herself, or he/she can use the automatic filtering mode. In 

the automatic filtering mode, the programme determines the filter limits. As this filtering 

technique is based on a coherence curve, digital filtering cannot be started before the 

measurement procedure has been finished. 

 

Illustration 3-6: Digital filters in the coherence 

When you intend to manually filter the results, you will have to determine the filter limits 

before you start the function. Setting the filter limits is done in the coherence diagram of the 

main mask (see chapter 3.1). In order to do so, move the cursor across the diagram and click 

on the blue part of the diagram with the left mouse key. A red vertical line will now appear in 

the diagram. This line abstracts the lower filter limit for your digital filter. Repeating this 

process at another position in the diagram will shift the filter limit.  

The upper filter limit is marked by clicking on the diagram with the right mouse key. A green 

line to indicate the upper limit will appear in addition to the red line, which indicates the 

lower limit of the digital filter. Both lines can be shifted by repeating the clicking with the 

particular mouse key. Whatever data is between the two lines will be used for the calculation 

of the leakage. The data left of the red line and right of the green line will not be considered 

for the leakage calculation process. Please make sure that the red line has is positioned to be 

left of the green line and the green line is positioned to be right of the red line so that the 

programme can calculate the leakage. If the positions of two lines are mixed up, the 

programme will issue incorrect results.  
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When both filter limits are set in the diagram, you can start the manual filtering process 

through the menu function (see chapter 2.2) or through the menu bar (see chapter 2.6). When 

the programme has finished the filtering process of the measurement values, it displays a new 

correlation in the diagram and updates the indication of the position of the leakage. 

The automatic filtering mode does not require any setting of the filter limits in the coherence 

as the programme determines the limits itself. You only have to call the menu level (see 

chapter 2.2) or to call the function in the menu bar (see chapter 2.6) to filter the measurement. 

Please note that the automatic digital filtering process is not feasible before the measurement 

procedure is finished. Calculating the filter limits may take up to ten seconds, depending on 

the circumstances. When the calculating process for the filter limits is finished, the filter 

limits are drawn in the coherence diagram and adapted to the illustration of the correlation. 

The indication of the leakage will be updated. 

3.8 Calibrating 

Calibrating enables the operator to determine the sound velocity on pipe sections. Please note 

that the leakage does not have to be located between the two measurement boxes, i.e. not 

within the measurement section. If so, the correlation as shown in Illustration 3-7 will be 

displayed. The diagram clearly shows that the leakage must be in front of measurement box 

A. In such a case, the programme indicates that the distance between the leakage and 

measurement box A is zero.  If, however, the leakage is not located outside the measurement 

section, such a correlation indicates that the sound velocity on the pipeline is incorrect. 

In both cases, you can use the Calibrating function (see chapter 2.2 and chapter 2.6) to 

make the programme adapt the sound velocity on the pipe. When the sound velocity has been 

adapted, the programme shows a new correlation in the diagram. The positions of the 

measurement boxes have now been changed and the distance between the two boxes in the 

diagram has been increased. The programme shifts the location of the measurement box 

closer to the peak of the correlation to the peak of the correlation seen previously. Either the 

leakage is now exactly at measurement box A, or the distance between the leakage and 

measurement box A precisely corresponds to the distance between the two measurement 

boxes. 
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Illustration 3-7: Calibration 

If you have to carry out a calibration process, proceed as described in chapter 3.5 or in 

Chapter 3.6 and carry out a measurement. When the result of the measurement is similar to 

what is shown in Illustration 3-7, you can start the calibrating process through the menu 

function of the Measurement menu (see chapter 2.3) or through the menu bar (see chapter 

2.6). 

3.9 Time and spectrum diagrams 

This part of the programme displays the time signal or the spectrum for a particular channel. 

The time signal is displayed as soon as a measurement object has been created, whereas the 

spectrum can only be displayed during the measurement procedure itself. In the Preference 

menu at the Channel diagram menu level, the operator can switch between the two 

indication modes. 

 

Illustration 3-8: Channel diagrams 
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4 User Dialogues 

This chapter is to provide a detailed description of the dialogues available in the programme. 

The dialogues are used to add further information to the a particular measurement or to 

change the settings in the programme. Chapter 4.1 is to describe the options available for the 

Report dialogue which help to add certain information in a text-format to a particular 

measurement. Chapter 4.2 is to describe the options and the range of functions available for 

the Sketch dialogue, and chapter 4.3 is to provide you with information on the Service 

provider address dialogue. Chapter 4.4 deals with the scope of functions of the 

Process material definitions dialogue, and the chapters 4.5 and 4.6 finally are to 

give you an overview of the Measurement section dialogue and on the dialogues for the 

configuration of the GPS interface. 

4.1 Reporting 

As already briefly mentioned in chapter 1.3, additional information on this dialogue can be 

input to generate a report and to print out this report together with the measurement diagrams. 

To call the dialogue, please proceed as described in chapter 2.2. When the dialogue has been 

called, the input mask as shown in Illustration 4-1 will appear on the screen. This mask offers 

four fields for input to the particular measurement. On the left-hand side, there are the fields 

for Address and Remarks, and in the right-hand side, there are the fields for Measurement 

points and Specialist 

 

Illustration 4-1: Reporting dialogue 

In the Address field, the customer’s address can be lodged. This address will then be shown 

on the head of the report. The field for Remarks will also be printed out. However, only the 

first four lines will be printed out on the report to save some space. In the Specialist field, 

the name of the colleague who carried out the measurement can be input. The boxes of the 

Measurement points field are used to input a description of the location for the 

measurement boxes A and B. This information is also shown on the printed-out report. 
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If you intend to accept the input information and to allocate it to the current measurement, 

please press the Accept button. Please note, however, that the also measurement itself has to 

be saved in order to save the information permanently. If the measurement has not been 

saved, the information will be lost. Therefore, you will have to press the Accept button to 

allocate the information to the particular measurement and then press Save in the Files 

menu (see chapter 2.1) to save the information. If you do not want to accept the input 

information, press Return.  

4.2 Sketches 

The correlation programme offers the option (dialogue) to draw a sketch and to save such 

sketch in combination with the corresponding measurement. This enables the operator to 

display the prevailing situation at the measurement point in a graphical way. When the 

dialogue has been started, the window as shown in Illustration 4-2 will appear.  

In order to be able to draw a sketch, either go to File → Sketch → Open to create a new 

work space or load an image file through the Open menu level. In addition, you have the 

option to insert images from the clipboard into the correlation programme. These images can 

be obtained, for example, from a mapping programme. For further details, please refer to the 

Preference – GPS Export menu (see Preference menu).   

 

Illustration 4-2 : Sketch window 
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4.2.1 Drawing a Sketch 

This dialogue offers a number of functions which are to assist you in drawing sketches. These 

functions are located to the left of the drawing area and are displayed through icon showing 

the corresponding geometrical shapes or any other symbol (see Illustration 4-2). 

Before you start drawing, select the symbol for the shape you intend to start the sketch with 

and click on the corresponding button. If you have selected a symbol from Category One (see 

Illustration 4-2, red marking 1), move the mouse pointer across the drawing area and keep the 

left mouse key pressed until the shape has the desired size. Now the corresponding shape is 

displayed in the drawing area and inserted as soon as you release the left mouse key. If you 

have selected a symbol from Category Two (see Illustration 4-2, red marking 2), move the 

mouse pointer across the drawing area and click with the left mouse key at the position where 

the symbol is to appear. The single symbols are explained below. 

   drawing a line    symbol for measurement box 1 

  drawing an ellipse  symbol for measurement box 2 

  drawing a rectangle  symbol for hydrant 

  drawing a rectangle with rounded 

corners 

 symbol for valve 

 freehand (see Illustration 4-2)  symbol for over-ground hydrant 

  insert text (see Illustration 4-2)  symbol underground hydrant 

   selection of colours 
  symbol for pipe fracture 

Tabelle 4-1: Symbols 
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4.2.2 Functions of the Menu 

Menu bar 

The menu bar holds the most frequently used menu functions as well as the lists for the 

“undo” and “restore” functions so that you can carry out different steps simultaneously. 

 

Illustration 4-3: Menu Bar 

The first three menu levels of the menu bar relate to the File menu and support the creation 

of a new sheet, the opening of an already existing image file, or the closure of the sketch 

programme. The subsequent two symbols relate to the Edit menu and host functions which 

are to undo / to restore any actions made on the drawing area. With the next symbol, you can 

adjust the settings appropriate to format texts. This function is also available in the 

Preference menu. The last symbol in the menu bar is the Insert tool required to insert an 

image from the clipboard into the sketch programme.  

The line thickness and the text to be inserted can be determined with the functions offered 

through the following menu bar (see Illustration 4-4). The line thickness is effective for all 

geometric shapes and can be increased or reduced as desired. If you want to insert a text 

passage into the sketch, enter the envisaged text into the menu bar and select the text symbol 

from the shape symbol list. Then click on the position in the sketch where the text is to 

appear. 

 

Illustration 4-4 : Text and freehand drawing menu bar 

The other menu levels of the sketch programme are explained in detail below. First, the File 

menu (see File Menu) with all its menu levels is presented, followed by the Edit menu. 

Finally, the Preference menu with all its functions is described. 

File Menu 

The File menu has the levels New, Open, and Close. By clicking on New, a new and 

empty ready-to-be-used drawing area will be created in the sketch programme. Menu level 
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Open lets you load already existing image files. The programme of the correlator is currently 

capable of processing raster graphics in JPG and BMP format, i.e. such files can be loaded 

into the sketch dialogue and can be processed there.  

Click on Close to shut down the dialogue. If the dialogue is shut down by clicking on 

Close, you will be asked by the programme if the sketch is to be saved, too, when the 

corresponding measurement is saved the next time. Confirm with Yes to save the sketch. If 

you click on No, the sketch will not be saved and the data will be lost. Please also note that the 

measurement, too, has to be saved in order to save the sketch enduringly. If the measurement 

is not saved, the sketch will also not be saved. 

Edit 

This function is to assist you during the drawing process by undoing or restoring up to the 10 

last actions carried out on the graphics. You can either undo / restore the action you did last or 

to undo / restore a number of actions at the same time. 

If you want to deal with only one action, you can call the particular function through the menu 

or through the menu bar. If you want to undo / restore several actions at the same time, click 

on the triangle in the middle of the menu bar (see Illustration 4-5, marking 1) to load the 

“Undo” list and “Restore” list respectively. These lists contain the actions carried out last, 

as can be seen in Illustration 4-5. 

 

Illustration 4-5: Undo - / Redo - List 
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Select an action and click on it to undo the particular action(s). The selected actions will then 

be inserted into the “Restore” list (see Illustration 4-5, marking 3) and remain listed – and 

thus be available for restoration purpose – until a new object has been drawn into the sketch. 

With the Insert function, you can insert a graphics from the clipboard into the sketch 

programme and then process this graphics (see also Illustration 4-5 , marking 2) 

Preference 

The Preference menu holds all the functions related to the Sketch dialogues which are 

used to change the drawing elements. For example, you can change all parameters for a text to 

be inserted at the Font menu level such as the font size, design, etc. before the particular text 

is added to the graphics. Another useful menu level is the Filling menu level. In this sub-

menu you can choose the desired filling for areas such as circles and rectangles. Additional 

tools to be used to vary and to display lines and areas are offered in the sub-menu levels of the 

Line Selection menu. 

Another function in the Preference menu is the GPS Export function, which allows you 

to export maps from a route planner system, preferably Microsoft AutoRoute or Google 

Earth, and to use such maps in the sketch programme.  

If the programme path to the applied mapping programme has not yet been saved in the 

correlator programme, a dialogue (Open Dialogue) as shown in Illustration 2-2 will appear. 

The path to the executable file has to be entered there, then the dialogue has to be confirmed 

by clicking on Open. If you intend to use, for example, Microsoft Autoroute, as the mapping 

programme, go to the installation directory of Microsoft Autoroute (e.g. 

C:\Programme\Microsoft Autoroute\ ) in the Open Dialogue menu and click on the 

AutoRout.exe file. Then click on Open in the dialogue.  

The selected mapping programme will now be started. If a GPS receiver has been connected 

to the system, it may be possible to have the current location indicated due to the GPS data 

received (subject to used application). For details about the configuration of the GPS data 

reception, please refer to chapters 4.6 and 5.3. 

If the programme containing the map-related data has been started, please copy the map 

section into the clipboard (for Microsoft Autoroute, go to Edit→ Copy, for Google Earth go 

to Edit → Copy → Copy Image). When you have copied the requested map section into 
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the clipboard, you can close the applied mapping programme. The correlator programme will 

note that the mapping programme has been closed and will automatically start loading the 

graphics from the clipboard and displaying it in the sketch. You can then process the graphics 

in the sketch programme. 

4.3 Address of Service Supplier 

Another dialogue to process information is the Supplier’s Address dialogue, which can 

be called through the Preference menu. Here you can save your address and a logo in the 

programme. In order to store a logo, click on Load.  A dialogue selection window will open; 

where you can choose a JPG or BMP graphics (see Illustration 4-6). 

 

Illustration 4-6 : Open the logo 

When you have selected the graphics, click on the Open button in the dialogue. The graphics 

will appear in the Supplier’s Address window (see Illustration 4-7). The address and the 

logo will now be printed out in the headline of every report. Press Accept to write the 

address directly into the configuration file (chapter 5.1) of the correlator programme. This 

means, the information contained in this dialogue can be saved in the programme irrespective 

of any measurement. If you click on Back, you will delete your input and return to the main 

mask of the programme. If you want to delete the saved logo, click on Delete. 
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Illustration 4-7: Supplier’s address dialogue 

4.4 Material definitions 

In order to exploit the full supportive potential of the programme when creating a 

measurement section and calculating the sound velocity defined for the stated pipe material, 

the kinds of pipelines have to be entered into this dialogue beforehand. The installation file 

already contains the most common seven types of pipelines and their particular sound 

velocities for various pipe diameters. So if you intend to process these seven types of 

pipelines or add some new kinds to the programme, you can do this through this dialogue. As 

can be seen in Illustration 4-8, the dialogue is separated into two sections: the left-hand 

section is used for the kinds of pipelines, and the right-hand section deals with the particular 

sound velocities and the pipe diameters.  

In the left-hand section, the operator can create or delete certain kinds of pipelines by clicking 

on the section with the left mouse key. A context menu will open and will offer two menu 

levels: one to create a new kind of pipeline and another to delete the selected kind of pipeline.  

When you intend to create a new kind of pipeline, open the context menu and select the first 

menu level to open a window where you can enter the name of the new type of pipeline. If 

you want to confirm the dialogue or to accept the kind of pipeline in the  Material 

definitions dialogue, press the OK button. Click on the Cancel button to reject the 

entered data. When the input has been confirmed by pressing the OK button, the new material 

definition will be shown in the field on the left side of the dialogue. If you want to delete a 

certain material definition, mark the definition concerned and call again the context menu by 
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clicking the right-hand mouse key. Select the second menu level. The marked pipeline 

definition is now deleted. Please note that the pipeline definition has now been irreversibly 

deleted and cannot be restored by the programme. 

 

Illustration 4-8: Pipeline definitions 

As mentioned at the beginning of this chapter, the field on the right-hand side is used to 

process sound velocities and pipe diameters of the particular marked kind of pipeline. When a 

particular type of pipeline has been marked, it can be processed by a single click on the 

particular value. The values of both the diameter and the sound velocity can be varied 

unrestrictedly.   

When you have done all the changes, these changes can be integrated into the programme by 

clicking on the Accept button. If you do not want to maintain the changes made, press 

Return and you will go back to the main mask, the data will not be saved. 

Note: The pipeline type will not be translated when the dialogue language of the programme 

is changed as the types of the pipelines are saved in a separate file. Concerning the translation 

of the names of the types of pipelines, please refer to chapter 5.1. 
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4.5 Setting the measurement section 

The Setting the measurement section dialogue is used when the measurement 

section has to be entered. Go to the Preference menu and then to the Add a 

measurement section menu level to open the dialogue. In this dialogue, you can enter up 

to seven different partial measurement sections of a pipeline to be checked. One line 

containing the information on Material, Length, Dimension, and Sound velocity 

corresponds to one partial section of a pipeline. All four boxes need to contain some 

information as otherwise the entire line will not be considered for the calculation of the 

measurement results. 

 

Illustration 4-9: Material selection 

If you want to enter the data related to a certain partial measurement section, first select the 

material in the selection box in the Material field. This selection box contains all types of 

pipelines which have been created in the Material definitions dialogue (see chapter 

4.4). So the programme will automatically determine the sound velocity if some information 
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has been entered into the Length and Dimension fields. Of course, you can also modify the 

sound velocity later by pressing the arrow keys at the Sound velocity field or by entering 

a certain value directly into the box. If you want to enter the data related to several partial 

measurement sections, just repeat the process in the next line(s).  

Press Accept at the lower part of the mask so that the programme can accept the settings you 

selected. The measurement section is saved now and will be displayed in the Measurement 

Section (see Illustration 1-3) of the main mask. When the Setting the measurement 

section dialogue is called again, the data you have entered will be displayed in the dialogue. 

Click on Return if you do not want to save the information you have entered. You will now 

go back to the main mask without having created a measurement section. 

4.6 GPS interface 

In order to be able to receive and to process GPS data, certain settings have to be made to the 

programme, and the GPS receiver has to accept the programme requirements. This paragraph 

is to describe the configuration of the programme required to process the GPS data. Chapter 

5.3 is to inform you about the technical requirements the GPS receiver has to meet in order to 

be used for a data exchange via GPS. 

 

Illustration 4-10: Com-Port settings 

As already explained in chapter 5.3, communication with the programme is made through the 

serial interface. The interface can be either a real serial interface or a virtual serial interface. 

Both types of interfaces have in common that the communication parameters have to be 

determined prior to the start of the communication process. Through the GPS menu level of 

the Preference menu you will reach a sub-menu which will provide you at the first menu 
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level with the dialogue shown in Illustration 4-10. In this dialogue, all the parameters of a 

serial interface can be set. The settings required for the interface are stated on the packaging 

of the receiver. When you have configurated all the parameters of the interface, you can save 

the settings in the programme by clicking on the Accept button. Pressing the Return button 

will delete the settings made and take you back to the main mask of the programme without 

having saved the parameters. 

 

Illustration 4-11: Testing the connection 

When you have adjusted the interface, you can test the radio reception quality through the 

second menu level of the GPS sub-menu by clicking on the Open button which is shown in 

Illustration 4-11 on the left-hand side. When you use a GPS receiver which supports the 

NMEA 0183 protocol, the Communication test dialogue will issue a similar message as 

shown in Illustration 4-12. As soon as the message has been displayed, the programme is 

ready for GPS operation and can process and display the data as shown in Illustration 4-2 

(lower part). 

$GPGGA,100539.000,4913.0052,N,00925.4911,E,1,04,5.5,215.9,M,48.0,M,,0000*5E 

$GPGSA,A,3,18,21,22,07,,,,,,,,,7.3,5.5,4.9*36 

$GPRMC,100539.000,A,4913.0052,N,00925.4911,E,0.26,112.34,120207,,*01 

$GPVTG,112.34,T,,M,0.26,N,0.5,K*64 

Illustration 4-12: issuing the NMEA protocol  
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5 Technical Information 

This chapter mainly focuses on the technical features of the programme. Especially the 

configuration files required to save the settings as well as the material definitions are 

described in chapter 5.1. Chapter 5.2 is to describe the creation and the processing of the 

language-related files which are integrated into the programme to change the information 

output. Finally, chapter 5.3 is to describe the technical requirements for the connection of a 

GPS receiver. 

5.1 Configuration files 

The correlator programme requires two configuration files which are created either during 

installation or through the initial start of the programme. The configuration file MatDef.md, 

which is created during the installation process, is the file for the material definition data. This 

file contains all information on the types of pipelines used in the programme and processed 

through the dialogue as described in chapter 4.4. Please note that when the programme 

language is changed, the material definitions are not translated automatically as the data is 

saved in a separate file. Translating the names of the pipeline definitions, however, can be 

made manually by opening the file MatDef.md with an editor and renaming the single 

expressions. The file is found under the following path: 

• Installationspfad/MatDef/MatDef.md 

This means: If the correlator programme was installed under the installation path 

C:/Programm/Fast/Korrelator, the file is saved under the path 

C:/Programm/Fast/Korrelator/MatDef/MatDef.md. So when you want to process 

the file, first open the folder which contains the MatDef.md file. Open the context menu by 

positioning the cursor on the file and click on the right mouse key. A context menu will 

appear, and you should select the first menu level (Open). You will then be asked which 

programme you want to use in order to open this file. From the list of programmes shown on 

the screen you can now select either the Editor programme or the WordPad programme. 

Click on OK to open the file. When the file has been opened, the Editor (or WordPad) 

shows a text similar to the one shown in Illustration 5-1. 

[AZ] 

12=1370 
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50=1250 

... 

[cast] 

12=1390 

20=1385  

... 

[lead] 

12=1190 

20=1150 

... 

Illustration 5-1: MatDef.md file data 

As can be seen in Illustration 5-1, the names of the different materials are listed in square 

brackets, and the definitions of the particular diameters and sound velocities are listed next 

(diameter = sound velocity). When an expression has to be replaced (translated), first 

replace the particular expression (e.g. the German word [lead]) with the new expression 

([Lead]). We recommend to adapt the pipe diameters and the particular sound velocities 

through the dialogue as stated in chapter 4.4. As soon as the conversion has been finished, 

please save the file under the same name and path. 

Another file which contains certain settings concerning the runtime of the programme is the 

file Korrel.conf. Especially the positions of the single windows, the service provider ‘s 

address, and the saving paths are saved in this file. So if you delete this file, the programme 

will be reset to the installation status. The file Korrel.conf can be found under the 

following path: 

• C:/ Dokumente und Einstellungen / aktueller Benutzer / FastGmbH 

/ Korrelator / Korrel.conf 

5.2 Language files 

The programme can feature ten different languages, as already mentioned in chapter 2.4. 

However, only German and English are included as a standard in the installation of the 

programme. The other languages are not available immediately when the programme has been 
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installed and are thus not selectable through the Preference menu. The concept of 

multilingual applicability is implemented in the correlator programme through certain 

language files, which have to be named as listed below in order to be identified by the 

programme. 

• german.lng 

• english.lng 

• french.lng 

• italian.lng 

• spanish.lng 

• portuguese.lng 

• swedish.lng 

• norwegian.lng 

• danish.lng 

• polish.lng 

In addition, the location where these files are saved is determined by the programme. If a new 

language file is to be added to the language file pool, the new language file has to be filed in 

the folder lang of the programme. For example, of you want to add Polish, you first have to 

create a file with the name polish.lng. This file then has to be copied into the folder lang 

of the programme. The folder for the language files is located in the installation path of the 

correlator programme. If, for example, the programme was installed under the path 

C:/Programme/Korrelator, the folder lang can be found under this path. Therefore, the 

language file named polish.lng has to be copied to C:/Programme/Korrelator/lang. 

The design of a language file also follows the requirements of the programme and has to be 

kept to so that the programme is able to integrate the file exactly. Illustration 5-2 shows an 

excerpt of the design of a language file. The first line of each language file contains the 

country code in square brackets. This code is absolutely necessary to integrate the file 

precisely. The key follows the naming of the language file: if the language file is named 
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norwegian.lng, the key to be hosted in the first line is [norwegian] and for 

portuguese.lng it is [portuguese]. 

[german] 

GB HochPass=Hochpassfilter 

GBTiefPass=Tiefpassfilter 

GBVerstaerkung=Verstärkung 

... 

Illustration 5-2: Design of the language file 

When the language file and the country code have been named correctly, the expressions to be 

translated can be translated into the particular language. The structure of the file is as follows:  

First, the key object is stated followed by the expression to be translated. Both expressions 

will be separated from each other by means of an equals sign without any blank space. As 

shown in lines two to four in Illustration 5-2. For example, for the expression 

Hochpassfilter to be translated (see Illustration 5-2), GBHochPass is the key object which 

must not be changed, and Hochpassfilter is the expression to be translated which can be 

changed. To make sure that all keys are translated and none is neglected, we may recommend 

that you copy a language file and make the necessary changes on this copied file. 

5.3 GPS receiver 

Communication between the correlator programme and a GPS receiver is done through a real 

or a virtual serial interface under Windows. Windows provides a communication connection 

for the communication with external devices. This connection is not limited to a certain 

hardware and is treated like a serial interface. This means that the interface is available in the 

system as ComPort. As the correlator programme uses this ComPort (see chapter 4.6), you 

may use any GPS receiver which is capable of communicating through this interface. So you 

can use receivers which are connected with the computer via RS-232, USB, IrDA or 

Bluetooth as long as they are accessible through a ComPort in the system. The second 

requirement to be met by the GPS receiver in order to be able to communicate with the 

correlator programme is the transfer protocol for the GPS data. The programme processes 

GPS data which meets the NMEA 0183 protocol standard. So if your receiver delivers the 

GPS data according to this protocol through the serial interface, the programme can process 

the data. Especially the information of the two tags $GPGGA and $GPRMC of the NMEA 
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protocol are processed. The receiver has to deliver at least one of the two tags to enable the 

programme to extract from the GPS information. If these preconditions are met by the GPS 

receiver, it can be used for the data exchange with the correlator programme. 
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